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Digital Dave
“Digital Dave answers your tech questions.” by Digital Dave

Is Comodo Safe?; Mystery Internet Files; Tracking Cookies.

Is Comodo Safe?
Dear Digital Dave,

I would like your opinion of Comodo. I read recently on Kim Komando that it was a far
superior firewall to Security Essentials and I downloaded it. After the download, a message
came up that said I needed to call a number to configure it. The gentleman on the line
convinced me, against my better judgment, to let him take over my computer to complete the
download.

The next morning, I had a very slow computer, a pop-up indicating I had problems, and a
number to call. The gentleman said I had several things wrong with my computer, and it
would cost "this amount" to repair it. I declined and removed Comodo. I would consider that
a perfect scam, but it was Kim Komando's recommendation.

Your thoughts, please.
Sally - a long time reader
Albert Lea, MN

Dear Sally,

As time goes on, businesses look for more and more ways to make money. This often leads to
decisions that in the long run hurt their reputation. As your letter demonstrates, Comodo has
fallen victim to this temptation. Sometimes it takes the form of installer programs that place
toolbars in your browser and change home pages. Other times it takes the form of a bait-and-
switch—as it appears to be in your case. You are not the only one to become annoyed with
Comodo as shown by these articles, "Paying a price to use free software: the dark side of
Comodo products" and "Comodo Scam Alert."

I have seen where Comodo has received a number of high rankings from well known
magazines. That's one of the reasons I don't rank products. How can anyone know what's
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going on behind the scenes? While I do often recommend CNET's Download.com for
obtaining free software, I caution people that their installer will add toolbars if you don't watch
carefully during installation. Even open source software occasionally falls victim to the
temptation ("FileZilla + Sourceforge installer = insecure connections and malware"). You are
wise to keep your eyes wide open.

Digital Dave

Mystery Internet Files
Dear Digital Dave,

I surf the Net using Mozilla Firefox. The news sites are a favorite. I notice that tiny files
appear to be sent to my computer. CCleaner displaying Firefox Internet Cache indicates that
they number in the hundreds, are not cookies and have a total file size of 80+ megabytes.
Most cause no problem with the exception of ad.doubleclick.net. This file fails to load some
of the time and causes me to leave the offending site. Can these files harbor malware and
what is their purpose?

Thank you,
Bob
San Diego, CA

Dear Bob,

When you load a Web page via a browser, the page and its bits and pieces (mostly graphic
files) are saved in the cache. The purpose of this is to make reloading the page much faster.
Rather than downloading everything from the Web on a revisit, the unchanged pieces are
loaded from the cache on your hard drive. That's why there are times when you need to
Reload or Refresh to make sure a page is up-to-date.

The files are no more dangerous than the Web page itself. Browsers interpret HTML and
JavaScript (plus any plug-ins you add). Both are insulated from the rest of the operating
system by your browser. You are not likely to have a problem unless you actively click a
download link with questionable files on the other end. You can delete these files at any time
with the only result being a slightly slower loading speed when you revisit a Web page and the
files are saved to the cache again.

Plug-ins can expand the browser beyond the usual HTML and Javascript—Flash and PDF for
example. Those have caused problems in the past though they seem fine now as long as you
run anti-virus software. Then, there were the old Microsoft ActiveX controls in Internet
Explorer which would allow Web pages to do things to your PC, but ActiveX is disabled by
default in current versions of Internet Explorer. This was another reason that people moved
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away from Internet Explorer.

Digital Dave

Tracking Cookies
Dear Digital Dave,

I have free AVG antivirus and use Spybot immunization. Spybot still detects and deletes the
same seven tracking cookies after about three days of Internet. I'm using Windows XP SP3.
Is there any antivirus that prevents those tracking cookies such as Zedo and Stat Counter
from running on my desktop? Does an iPad have the same problem?
James Taylor
San Diego, CA

Dear James,

Whether you get cookies from tracking sites or not is a function of the Web browser rather
than your antivirus software. In fact the cookies maintained by one browser (Google Chrome)
cannot be read by another (Firefox, Internet Explorer, and others). That means you can limit
the effectiveness of any tracking by merely changing browsers. Also, deleting cookies severely
limits tracking, but that can affect the cookies you want to keep—regular sites that maintain
your personal settings in cookies.

Notably tracking cookies have a name different from the site that you're visiting. This is done
so multiple Web sites can read the same cookie (always in the same browser). Since they don't
use the name of the site, they are called third-party cookies. Some browsers allow you to
block third-party cookies while others merely tell sites that you don't want to be tracked.
(Which approach do you think is more effective?) Both Chrome and Internet Explorer have an
option to block third-party cookies while Firefox allows you to make a request not to be
tracked.

To block cookies in Internet Explorer see Internet Options => Privacy => Advanced => Third-
party Cookies => Block.

To block cookies in Google Chrome see Tools => Settings => Show advanced settings… =>
Privacy => Content Settings => Block third-party cookies and site data.

In Firefox make your request not to be tracked with Tools => Options => Privacy => Tell
sites that I do not want to be tracked.

Of course blocking is more effective since not everyone obeys the rules.
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On the iPad in Settings Safari has an Accept Cookie from Visited (only?) feature which I
assume means not to accept third-party cookies. Google Chrome on the iPad only offers the
request to be left alone.

Digital Dave
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VLC Free Media Player
“More Free Software Recommended by ComputorEdge Readers” by Jack Dunning
Jack takes a look at using VLC Media Player for listening to music and watching videos.

One thing I noticed about the lists of free software offered by many ComputorEdge readers in
response to the "Free Software I Actually Use" article was the inclusion by many of VLC
Media Player. I don't usually listen to music or watch videos on my computer, but I was
intrigued by how many people make VLC Media Player a standard part of their setup. After
all, virtually all computers come with some type of media player. I decided to take a closer
look.

VLC Media Player
VLC Media Player is open source which means it's free to anyone who wants it. It's available
for Windows, the Mac, Linux computers, plus iOS (iPhone and iPad) and Android for
smartphones and tablets. This universality is probably enough of a reason to download the
program, but many people tout VLC's simplicity and flexibility. As ComputorEdge reader
Andy Kliss states, "it will play just about anything you throw at it, plus includes some editing
capabilities."

VLC plays music and videos regardless of whether it is files, discs, Webcams, devices or
streams—although I did have a little trouble figuring how to get it to stream a YouTube video.
The program is mostly intuitive only requiring you to select a file, folder or disc, (see Figure
1).
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Figure 1. VLC Media Player allows you to pick individual files, entire folders, or a disc.

Admittedly in many areas of the program I did encounter terminology that I didn't quite
comprehend (i.e. graphic equalizer, compressor, spatializer, and more). But overall it was easy
to select and play audio and video files.

The program already contains almost all the codecs you need to play just about anything
without adding more packs (MPEG-2, DivX, H.264, MKV, WebM, WMV, MP3…). I tested
it on some old AVI files which have often had problems with on another player (Windows
Media Player) and it breezed right through them.

Many of the controls are immediately available in a right-click menu—always one of my
favorite ways to navigate an app (see Figure 2).
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Figure 2. The background mode can be changed with the right-click menu.

Staring at a blank window when listening to music is not for everyone. If you like the
exploding colors similar to those shown in Figure 2, then selecting Goom from the
Visualizations menu might be for you.

One neat trick was playing a variety of family videos buried in a multitude of folders with
thousands of image files. After adding the top level folder, VLC automatically loaded all for the
videos into the list. This saved a lot of sifting through the picture files looking for videos (see
Figure 3).

August 22, 2014 VLC Media Player

11



Figure 3. VLC plays most video formats without any problem.

The Playlist
One of the features of any media playing software is the playlist which consists of all the files
that have been added to the player. This list can be rearranged to your preferred order or with
the click of a button they are played in random order. Best of all the playlist can be saved to a
file for later reloading.

After selecting the files you want to play the current selections can be viewed by selecting
Playlist from the View menu (see Figure 4).
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Figure 4. The Playlist view shows all of the items in the current list.

Sometimes you just need music or video in another format. VLC can do media conversion for
almost any purpose.

I was under the impression that VLC would burn CDs. After all, Windows Media Player will
write to a CD-R disc. I was wrong! (See this video "How to Burn with VLC." I can add that
one to my bag of tricks that you can't do!) VLC does not burn CDs or DVDs. It's just a media
playing program and conversion program and not the software for making your mixed CDs.

Windows Media Player does an excellent job of burning CDs. Just drag the titles you want
to add into the burn list on the right side of the window under the Burn tab. Sort them in the
order you want them. Put a blank CD-R into the burner drive and click Start Burn. It even
keeps track of how many will fit on the disc.

Since I'm brand new to VLC Media Player, I may be missing some of the most important
benefits to using it as a standard free add-ons. If you have other reasons for liking VLC please
let us know why your prefer it.

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
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Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.

Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.

August 22, 2014 The Playlist

14

http://www.computoredgebooks.com/Free-AutoHotkey-Books-All-Formats_c36.htm?sourceCode=writerstag
http://www.computoredgebooks.com/AutoHotkey-Applications-All-File-Formats_c31.htm?sourceCode=writerstag
http://www.amazon.com/gp/product/B00B8Z2ASG/ref=as_li_ss_tl?ie=UTF8&camp=1789&creative=390957&creativeASIN=B00B8Z2ASG&linkCode=as2&tag=comput0b9-20
http://computoredgebooks.com/A-Beginners-Guide-to-AutoHotkey-All-File-Formats_c29.htm?sourceCode=writerstag
http://computoredgebooks.com/Digging-Deeper-into-AutoHotkey-All-File-Formats_c30.htm?sourceCode=writerstag
http://www.computoredgebooks.com/Cartoons-Computer-and-Internet_c21.htm?sourceCode=article
http://www.computoredgebooks.com/Special-Free-E-Book-Offer_c28.htm?sourceCode=article
http://www.computoredgebooks.com/Windows-8-Ebooks-EPUB-for-iPad-Nook-and-MOBI-for-Kindle_c22.htm?sourceCode=article
http://www.computoredgebooks.com/E-Book-Bundles_c18.htm?sourceCode=article
http://www.amazon.com/gp/product/B007AL672M/?&tag=comput0b9-20
http://www.amazon.com/gp/product/B00758J4L6/ref=as_li_ss_tl?ie=UTF8&tag=comput0b9-20
http://www.computoredgebooks.com/Cartoons-Computer-and-Internet_c21.htm?sourceCode=article


Quick
Dictionary
Lookup from
Any Program
“One Script Fails, But There

Is Always an Alternative” by Jack Dunning
Pulling data from a Web site for an AutoHotkey app can be tricky. Sometimes it's just easier to use the
site itself.

This week I'm taking a break away from the CalorieCount app, but I'll get back on it with
more improvements next week. (I'm even planning to add a graph of weight loss.) This
week's column is at a novice level using a standard technique for accessing searches within
a Web page. If you're new to AutoHotkey, you may want to review this "Introduction to
AutoHotkey!"

An e-mail from Ron Cerrato:

I just noticed this weekend that the Dictionary app doesn't work. Then I found your post [on
the AutoHotkey forum]:

Jack Dunning Last active: Aug 15 2014 08:41 PM
Joined: 08 Apr 2013

The Dictionary script seems to no longer work. Something probably changed on the
Dictionary.com page and as far as I know there is no update. That's the problem with
scripts that depend upon automatically pulling data from Web pages.

I'm surprised there is so little info about dictionary apps for Windows. It's so useful,
especially since you can highlight a word anywhere, even Notepad. Lately, when I want to
check the spelling of a word or look up its meaning, I enter it into a blank Notepad file just
so I can use the script.

*                    *                    *

It's a little frustrating when a script suddenly stops working. This Dictionary app was one that I
used regularly, so I noticed right away when it ceased returning definitions. Most likely
Dictionary.com reformatted the Web page causing the cues that Robert Ryan used to parse
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the definitions to be invalid. Fixing the problem would require taking a look at the Web page
source code and a little more knowledge of Regular Expressions than I possess. Even then,
there is no guarantee that the Web page won't change again in the near future.

I've put together a short alternative AutoHotkey script to do a Dictionary.com lookup. It's not
as slick as Ryan's, but it works. Plus, if you want to do a quick lookup of a word, you don't
need to open Notepad first. (Ryan's script did have a pop-up for quick definitions.) What the
script does is save any highlighted word to the Windows Clipboard, then uses it as a search
term on Dictionary.com:

^!d::
    Clipboard =
    Sleep, 100
    Send, ^c
    ClipWait, 1
    Run, chrome.exe  --new-window http://dictionary.reference.com/browse/%clipboard%?s=t
Return

If you don't highlight a word, then the site opens ready to search. This snippet of code can be
added to the end of any AutoHotkey script.

How It Works
After loading, the hotkey combination CTRL+ALT+D (^!d) activates the search. Of course,
you can change this combination to anything that you prefer. If you have not highlighted any
text, then Google Chrome will open in a new window, navigate to Dictionary.com and display
the home page with the search field (see Figure1).
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Figure 1. If no search term is highlighted, Dictionary.com opens on its home page with the search field at the top.

It was important to me for Chrome to open in a new window because I always have number
of other sites open for monitoring in a main Chrome window. By opening in a new window, I
can quickly close it without affecting all my other open sites and be right back where I started.

If a term is highlighted, then it is used to open another new Chrome window which
automatically searches for that word (see Figure 2).
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Figure 2. If text is highlighted (in this case the word "exist"), Dictionary.com automatically does a search for the word.

If the word is not found at Dictionary.com, then a list of possibilities is offered (see Figure 3).
One advantage to this approach over the original script is that all of the features offered at the
site are available including more alternative definitions, synonyms, and many more word
suggestions.
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Figure 3. If a word is not found or misspelled, then a list of alternatives is offered.

On the downside, since this script uses a Web browser, there can be a significant delay while
loading the page. I found that if the browser is already open on another page, then the new
window loads much quicker. This works for me because I always have the browser loaded
monitoring a number of pages—mostly ComputorEdge admin pages.

As opposed to the original app, you are forced to deal with the ads on the site, but that's a
small price to pay for a much simpler script that's not as likely to break if the site changes.
Plus you get the advantage of all the extra Dictionary.com features.

How the Script Works
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First the Clipboard is cleared with the Clipboard = line of code. This is necessary just in case
you didn't highlighted a search term. Otherwise, the search would be attempted with whatever
happened to be in the Windows Clipboard. It also makes the later ClipWait command work
properly. The Sleep, 100 allows time for the Clipboard to clear.

If you have selected text, then Send, ^c will copy it to the Clipboard. Rather than using another
Sleep command, to give the command time to complete, the ClipWait command causes the
script to pause until data is found in the previously blank Clipboard. The ClipWait parameter
is set to 1 to timeout after one second. Otherwise, whenever there is no selected text, the script
would wait indefinitely.

The bulk of the work is done with the Run, chrome.exe --new-window
http://dictionary.reference.com/browse/%clipboard%?s=t line of code. The Run command
calls Google Chrome. Note that I didn't need the full path to the program, but I can't guarantee
this will work on all Windows systems. (If doesn't work for you, right-click on a Google
Chrome shortcut and select Properties. The full path will be found in the Target field under the
Shortcut tab.)

I added the --new-window switch because it forces Chrome to open a new window. I didn't
want it to come up as a tab in my primary Chrome window. The remainder of the line is the
URL for Dictionary.com with the search term added. The search term which is saved in the
Clipboard is evaluated with %clipboard%.

This snippet only works for Google Chrome. For Firefox you should replace the Run
command with:

Run, firefox.exe -new-window  http://dictionary.reference.com/browse/%clipboard%?s=t

Notice that the -new-window switch only has one leading hyphen rather than the two for
Chrome.

I couldn't find a new window switch for Internet Explorer. It appeared to open a new window
in any case, but there could be a setting somewhere in Tools => Options. However, I did find
that I needed to use the full path to the program. Replace the Run command in the snippet
with the following line for Internet Explorer:

Run, C:\Program Files\Internet Explorer\iexplore.exe
               http://dictionary.reference.com/browse/%clipboard%?s=t

(This line is wrapped into two lines for display purposes only. If you use it in a script, it
should be all one line.)

Moving and Resizing the Window
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The new window often opens in full screen mode which might cover up your current working
window. (I found this to be inconsistent.) If I resized the window and ran another search
without closing the last window, the new window usually conformed to the same location and
size. (Again, this was inconsistent.) This is not an ideal situation, so I added another hotkey
combination to move, resize and make any active window always-on-top:

 ^!r::
  WinMove,A,,800,50,600,800
  WinSet, AlwaysOnTop, Toggle, A
Return

First, the target window must be selected (active). Using the CTRL+ALT+R (^!r) hotkey
combination the window is moved to the x,y coordinates 800,500 and resized to 600px by
800px using WinMove, A,, 800, 50, 600, 800. This will work on any active window—not just
the dictionary site. (You should adjust the numbers to match your monitor size.)

Next, the window is set to always-on-top with WinSet, AlwaysOnTop, Toggle, A. I like this
because I can move back to the working window without losing sight of the dictionary
definition. Plus, I can easily drag text from the definition window without it disappearing
behind the original window. Since the WinSet is a toggle, if I accidentally resize and set a
window to always-on-top, I can undo always-on-top by hitting CTRL+ALT+R again.

This AutoHotkey technique can be used with any Web site with a standard lookup feature. It's
very similar to the one used in the CalorieCount script for importing food data. I've already
replaced the old Dictionary app with this technique. We'll see how it works out.

*                    *                    *

Just released! AutoHotkey Tricks You Ought To Do With Windows! This e-book includes both
those tips and the reference material (Table of Contents and indexes) from the other three
AutoHotkey books. Pick up a copy free and share it with your friends.

*                    *                    *
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The second edition with more chapters and an index to the
AutoHotkey commands found in the book is available in e-book
format from Amazon (and other formats—EPUB and PDF— at
the ComputorEdgeBooks Web site linked below). Jack's A
Beginner's Guide to AutoHotkey, Absolutely the Best Free
Windows Utility Software Ever!: Create Power Tools for
Windows XP, Windows Vista, Windows 7 and Windows 8
(preferred, EPUB format for iPad, Android, and computers;
MOBI for Amazon Kindle; and PDF for printing) offers a gentle
approach to learning AutoHotkey. (Also available from Amazon
for the Kindle and Kindle software on other devices.)

Building Power Tools for Windows XP, Windows Vista,
Windows 7 and Windows 8, AutoHotkey is the most powerful, flexible, free Windows utility
software available. Anyone can instantly add more of the functions that they want in all of
their Windows programs, whether installed on their computer or while working on the Web.
AutoHotkey has a universality not found in any other Windows utility—free or paid.

Based upon the series of articles in ComputorEdge, Jack takes you through his learning
experience as he explores writing simple AutoHotkey scripts for adding repetitive text in any
program or on the Web, running programs with special hotkeys or gadgets, manipulating the
size and screen location of windows, making any window always-on-top, copying and moving
files, and much more. Each chapter builds on the previous chapters.

For an EPUB (iPad, NOOK, etc.) version of A Beginner's Guide to AutoHotkey click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of A
Beginner's Guide to AutoHotkey click here!

*                    *                    *

Jack's second AutoHotkey book, Digging Deeper Into
AutoHotkey (preferred, EPUB format for iPad, Android, and
computers; MOBI for Amazon Kindle; and PDF for printing) is
comprised of updated, reorganized and indexed columns from
ComputorEdge is now available. Since the columns were not all
written in a linear fashion, the book has been reorganized and
broken up into parts by topic. The book is not for the complete
beginner since it builds on the information in A Beginner's Guide
to AutoHotkey. However, if a person is reasonably computer
literate, they could go directly to this book for ideas and
techniques without the first book. (Also available from Amazon
for the Kindle and Kindle software on other devices.)
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For an EPUB (iPad, NOOK, etc.) version of Digging Deeper into AutoHotkey click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of
Digging Deeper into AutoHotkey click here!

*                    *                    *

Jack's third AutoHotkey book AutoHotkey Applications
(preferred, EPUB format for iPad, Android, and computers;
MOBI for Amazon Kindle; and PDF for printing) is an
intermediate level book of ideas and applications based primarily
on the AutoHotkey GUI command. The book emphasizes
practical applications. The book is not for the complete beginner
since it builds on the information in the other two books.
However, if a person is reasonably computer literate, they could
go directly to this book for ideas and techniques without the other
books. There is an extensive index to the ideas and techniques
covered in the back of the book. (Also available from Amazon
for the Kindle and Kindle software on other devices.)

For an EPUB (iPad, NOOK, etc.) version of AutoHotkey Applications click here!

For a PDF version for printing on letter size paper for inclusion in a standard notebook of
AutoHotkey Applications click here!

Jack is the publisher of ComputorEdge Magazine. He's been with the magazine since first
issue on May 16, 1983. Back then, it was called The Byte Buyer. His Web site is
www.computoredge.com. He can be reached at ceeditor@computoredge.com. Jack is now in
the process of updating and compiling his hundreds of articles and columns into e-books.
Currently available:

Recently released is Jack's FREE AutoHotkey book, AutoHotkey Tricks You Ought to Do
with Window, available exclusively at ComputorEdge E-Books in the EPUB for e-readers and
tablets, MOBI for Kindle, and PDF for printing formats.

ComputorEdge E-books offering is his AutoHotkey Applications, an idea-generating
intermediate level e-book about using the AutoHotkey Graphical User Interface (GUI)
command to write practical pop-up apps for your Windows computer. (It's not as hard as it
sounds.)

Hidden Windows Tools for Protecting, Problem Solving and Troubleshooting Windows 8,
Windows 7, Windows Vista, and Windows XP Computers.
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Jack's A Beginner's Guide to AutoHotkey, Absolutely the Best Free Windows Utility Software
Ever!: Create Power Tools for Windows XP, Windows Vista, Windows 7 and Windows 8 and
Digging Deeper Into AutoHotkey.

Our second compilation of stupid ComputorEdge cartoons from 2011 and 2012 is now
available at Amazon! That Does Not Compute, Too! ComputorEdge Cartoons, Volume II:
"Do You Like Windows 8 or Would You Prefer an Apple?"

Special Free Offer at ComputorEdge E-Books! Jack's Favorite Free Windows Programs:
What They Are, What They Do, and How to Get Started!.

Misunderstanding Windows 8: An Introduction, Orientation, and How-to for Windows 8
(Seventh Edition)!

Windows 7 Secrets Four-in-One E-Book Bundle,
Getting Started with Windows 7: An Introduction, Orientation, and How-to for Using
Windows 7,
Sticking with Windows XP—or Not? Why You Should or Why You Should Not Upgrade to
Windows 7,
and That Does Not Compute!, brilliantly drawn cartoons by Jim Whiting for really stupid gags
by Jack about computers and the people who use them.
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Wally Wang's Apple Farm
“Waiting for New Products” by Wally Wang

Waiting for New Products; Free Microsoft Office Alternatives; Talk like TED; The Future of OS X and
iOS Programming; A Petition for Classic Visual Basic; The Preview Program.

It's pretty easy to predict the future of Apple when the company leaves so many hints in plain
sight that often get overlooked by the media. If you have an Apple Developer account, you
can already access beta copies of both iOS 8 and OS X Yosemite, so it should be no surprise
that Apple will release the new iPhone 6 to coincide with the release of iOS 8.

Right now rumors point to a September 9 announcement for the iPhone 6 followed by actual
shipping a week or two afterwards. Nobody should be surprised if Apple releases two sizes for
the iPhone 6 so you can choose a larger screen (5.5-inch) or a slightly smaller screen (4.7-
inch), although both will still be larger than the current iPhone 5S screen (4-inch).

With the release of iOS 8, you can expect new iPad models too that will likely offer the
TouchID fingerprint sensor along with a faster processor and possibly a screen that's more
visible in bright sunlight.

Besides access to the betas of iOS 8 and OS X Yosemite, Apple Developer account holders
also have access to the latest version of Xcode 6 that offers several hints of the future. First,
Xcode 6 allows you to create iOS apps that can adapt to different screen sizes. That alone
should tell you that Apple is planning new iOS devices with various screen sizes.

In the early days when there was just the iPhone's 3.5-inch screen, Xcode just focused on
making apps that fit within that single screen size. Then Apple introduced the iPad, the larger
screen iPhone 5, and finally the iPad mini. Different screen sizes are now the norm, so Xcode
6's ability to let your iOS app adapt to different screen sizes points to more screen size
varieties in iOS devices for the future.

The second hint of the future buried in Xcode 6 involves its support for Apple's HealthKit and
HomeKit frameworks. HealthKit stores medical data while HomeKit lets you control devices
using voice commands with Siri. HealthKit hints at a wearable computer while HomeKit points
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to multiple third-party accessories that will likely be revealed at the same time as the iPhone 6
announcement. That way Apple can demonstrate the usefulness of HomeKit to control your
home using voice commands through your iPhone 6.

One new feature of OS X Yosemite involves Continuity, which lets you seamless move
between an iOS device and a Macintosh running OS X Yosemite. Start an e-mail message on
your iPhone and when you walk near your Macintosh, you can finish typing the rest of your e-
mail message on your Macintosh.

Of course to make this feature work, Apple has to release iOS 8 and OS X Yosemite at the
same time. With the release of OS X Yosemite, you can also expect new Macintosh models
such as a new Mac mini and iMac models. If you're thinking about buying a Macintosh, you
might as well wait until Apple officially announces OS X Yosemite so you can get a Macintosh
model optimized to run OS X Yosemite.

By this fall you can expect the iPhone 6, new iPads, new Macintosh computers, a wearable
computer running iOS 8 (iWatch?), and third-party accessories that connect to Apple's
HomeKit framework so you can control items around your house using voice commands.

If none of these promised items from Apple sound exciting because you don't like Apple, then
you can cheerfully wait for Microsoft to release the public preview of Windows 9 code-named
Threshold, which basically fixes the problems of Windows 8 just like Windows 7 fixed the
problems of Vista. With Windows 9, you can be finally be productive on your PC as if you
were using Windows 7. If that's your idea of innovation, feel free to ignore anything by Apple.

Free Microsoft Office Alternatives
For some odd reason, corporations stick with Microsoft Office because they demand complete
file compatibility with their existing Office documents. Of course, this ignores the fact that
each version of Microsoft Office introduces incompatibilities with older versions of Microsoft
Office. That means each version of Microsoft Office is never 100 percent compatible with the
previous version of Microsoft Office, but that fact gets swept aside under the belief that
Microsoft Office is crucial because of its perceived 100 percent file compatibility with Office
documents (even though it's not true). If that twisted logic makes sense to you, then you're
probably the type of person who also believes learning different ways that take more steps to
accomplish the same task is also an improvement. Therefore Windows 8 must be an
improvement over Windows 7 because 8 is a larger number than 7.

For everyone else actually capable of thinking, you'll quickly realize that a vast majority of
people don't need all the features in Microsoft Office. What people really need is the ability to
share Microsoft Office compatible files, which you can do with a variety of free alternatives so
you never have to spend money paying for Microsoft Office (and learning its Ribbon
interface).
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Anyone with a Macintosh can now use Apple's free iWork office suite that can open and save
files in Microsoft Office file formats. For Windows and Linux users, another popular
alternative is LibreOffice and OpenOffice, which are basically the same program with minor
differences. However both programs work nearly identically while letting you open and create
Microsoft Office files. If you don't think iWork, LibreOffice, or OpenOffice are valid options
because they don't offer 100 percent file compatibility with Microsoft Office, then you can
also eliminate Microsoft Office from consideration since Microsoft Office isn't fully compatible
with older versions of Microsoft Office either. If 100 percent file compatibility is your main
criteria, every office suite fails including Microsoft Office.

Since many Windows users claim they prefer Windows over the Macintosh because of the
lower cost of a Windows PC, they should apply that same logic in using free office suite
alternatives to Microsoft Office. In case you don't like LibreOffice or OpenOffice for some
reason, take a look at WPS Office instead, which is also free. (If saving money is your main
criteria, then save even more money by using the free Linux operating system and use a free
office suite instead of Microsoft Office.)

WPS Office is not only free, but also runs on Windows, Linux, iOS, and Android, which
makes it the first true cross-platform office suite that even Microsoft Office can't match. If
you want to use Microsoft Office on an iPad, you'll need to pay for a Microsoft Office annual
subscription that costs anywhere from $70 to $120 a year. If you use WPS Office on an iPad,
it won't cost you anything.

Figure 1. WPS Office lets you open, edit, and create Microsoft Office files.

Is WPS office completely compatible with Microsoft Office 2013? Nope, but neither are older
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versions of Microsoft Office. Does WPS Office offer all the features of Microsoft Office
2013? Nope, but neither do earlier versions of Microsoft Office.

If you're still paying for Microsoft Office, ask yourself why. With so many free alternatives
available, you might as well try them and see if one can meet your needs. If you're honest with
yourself, you'll likely find one free office suite that will work for you. If you want to lie to
yourself, just claim that you absolutely need Microsoft Office for file compatibility (even
though it's not 100 percent compatible with older versions of Office) and that paying for
Microsoft Office is cheaper than using something for free. Then you can also cheerfully
embrace the idea that ignorance is strength, which your own actions can demonstrate to
everyone around you.

Talk like TED
TED Talks have become famous for presenting interesting information from a variety of
topics. By limiting each speaker to 18-minute segments, TED forces speakers to condense
their talk, make it informative, and keep it interesting as well. If you've ever sat through a
dreadful PowerPoint presentation, you know that not every presentation has anything useful to
say in an entertaining manner.

In the book Talk Like TED, author Carmine Gallo identifies the three key elements that make
TED talks so compelling. First is that you have to make it emotional.

Nobody cares about facts (especially facts that directly contradict your beliefs). To make any
presentation interesting, Talk Like TED recommends that you first identify the emotional
element of your presentation. If it's not emotionally important to you, why would it be
interesting to anyone else?

That's why so many TED speakers start off with a personal story because well-crafted stories
of any kind let audiences experience your point rather than just have it presented to them as a
boring PowerPoint slideshow.

At the TED conference of 2004, author Malcolm Gladwell talked about how Campbell's Soup
created a spaghetti sauce to rival Ragu. Campbell's Soup asked people what they wanted in a
spaghetti sauce and got all kinds of answers. Then Campbell's Soup noticed that when given a
choice of different sauces, one third of Americans liked their sauce plain, one third like their
sauce spicy, and another third liked their sauce extra chunky.

That's when Campbell's Soup realized that nobody was selling extra-chunky spaghetti sauce
and that none of their consumer surveys revealed this information. Apparently when you ask
people what they want, they can only give you answers based on what already exists. Since
nobody was selling extra-chunky spaghetti sauce at the time, people didn't think that was an
option even though one third of Americans really wanted extra-chunky spaghetti sauce. If you
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solely rely on consumer research, your customers will never tell you what they really want
because they don't know how to articulate it.

This explains why market research never identified that people wanted an iPhone. In the early
days of mobile phones, people simply tolerated what was available, but couldn't tell you what
they really wanted. When Apple introduced the iPhone as a portable computer, suddenly
people could see the potential and bought the iPhone (and Android copycat phones) because
that was what they really wanted. Stories can make any presentation more interesting because
they can reveal insights that ordinary bullet points can never do.

Besides making a story emotional, Talk Like TED also suggest you make your presentation
novel in some way. In 2009, Bill Gates did this with his talk about malaria when he released a
handful of mosquitoes into the crowd. That demonstration of how easily it was to get infected
with malaria through a mosquito dramatically highlighted the importance of fighting malaria.

Finally, Talk Like TED suggests that you make your presentation memorable in some way.
The simplest way to do this is to add video and pictures because images are more interesting
than words. A stunt like Bill Gates releasing mosquitoes into the audience is also memorable
because it's different.

The next time you need to make a presentation, use these three techniques suggested by Talk
Like TED. Make it emotional, make it novel, and make it memorable. If you add all three
elements to your presentation, chances are good you won't bore your audience with another
mediocre PowerPoint presentation that says nothing and convinces nobody.

The Future of OS X and iOS Programming
It's not hard to predict the future of writing programs for OS X and iOS. When Apple
introduced their new Swift programming language, they basically defined their new
programming language of the future. Even though Apple will still support Objective-C for
creating OS X and iOS apps, Swift will be Apple's main focus. If you're interested in
programming for the Macintosh or iPhone/iPad/iWatch, you should learn Swift.

To help you learn Swift, you can visit Apple's official Swift programming blog. By following
blog updates from Apple's own programmers, you can get insights into the Swift programming
language from programmers with the most experience using Swift.

If you're interested in creating your own OS X or iOS apps, don't waste your time learning the
cryptic syntax of Objective-C. Instead, use Swift. Besides being easier to learn, Swift also
makes your code shorter and easier to read and write while eliminating common Objective-C
mistakes at the same time. Swift programs will generally be more reliable and bug-free than
comparable Objective-C programs.

The future of computers is easy to follow. Just embrace mobile operating systems like iOS and
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Android. To write Android apps, you'll need to learn Java, which is more complicated than
Swift. By making programming easier and less error-prone, Swift can attract new app
programmers while improving the reliability of their software. That gives Swift a huge
advantage over Java, which creates one more obstacle for Android programmers.

Since iOS and Android are dominating the smartphone and tablet markets, you can't go wrong
supporting either operating system. For novice programmers, iOS will be more attractive
because iOS users tend to spend more while Swift makes programming easier for beginners to
master.

With the introduction of Swift, Apple has made iOS more attractive for both developers and
iOS device owners alike. While iPhone and iPad owners won't know (or care) what language
their apps are written in, they will care if their apps aren't reliable. More importantly, Swift
only runs on Xcode, which means you need to buy a Macintosh to use it. Swift is one more
example of how Apple introduces products that gives people one more reason not to switch to
a rival product.

A Petition for Classic Visual Basic
If you visit the Classic VB site you can sign a petition asking Microsoft to continue support of
Visual Basic 6. In its time, Visual Basic literally changed the way people wrote programs.
Suddenly instead of wasting time creating both your program and its user interface, you could
focus on just writing your program and draw a perfect and reliable user interface. Visual Basic
made Windows programming easy, fast, and reliable.

Then Microsoft got the bright idea of turning the Visual Basic language into a more
complicated version of C# but with few benefits. Given the choice between switching to the
new Visual Basic.NET or just learning C#, many programmers simply abandoned Visual Basic
and switched to C#.

However, many Visual Basic 6 programmers need to maintain programs written in Visual
Basic 6. Since it's unlikely that Microsoft will listen to their petition to bring back Visual Basic
6, the simplest solution for Visual Basic programmers is to switch to Xojo.

Not only does Xojo closely mimic the Visual Basic 6 language, but it also lets you create
Windows, OS X, and Linux programs. By the end of this year, Xojo should also let you create
iOS apps.

If you're waiting for Microsoft to bring back Visual Basic 6, forget about it. Xojo is a far more
versatile solution with a future. Visual Basic 6 is dead and Visual Basic.NET only lets you
create Windows programs. Given the choice between the limitations of Microsoft or the
versatility of Xojo, the answer should be clear.

*                    *                    *
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If you're using Adobe Reader to view PDF files, you don't have to. The Preview program that
comes with every Macintosh is far more versatile and can even store digital signatures. Just
open the Preview program, click the Preview menu, and choose Preferences. Now click the
Signatures icon to display a Create Signature button.

Figure 2. Choosing Preview -> Preferences lets you capture a digital signature.

Sign your name on a piece of white paper and then click the Create signature button. Hold
your signature up to your Macintosh's webcam and click the Accept button to store your
digital signature in Preview.

Figure 3. Capturing a signature using the Macintosh's webcam.

Now when you want to add your stored digital signature to a PDF file, open that PDF file in
the Preview program, choose View -> Show Edit Toolbar to display the Edit Toolbar, which
normally remains tucked out of sight. Then click on the digital signature you want to use. (You
can actually capture multiple digital signatures so you can choose the one you want to use.)

Figure 4. The Edit Toolbar in the Preview program lets you choose a digital signature.

In the early days, before Wally became an Internationally renowned comedian, computer

August 22, 2014 A Petition for Classic Visual Basic

31



book writer, and generally cool guy, Wally Wang used to hang around The Byte Buyer
dangling participles with Jack Dunning and go to the gym to pump iron with Dan Gookin.

Wally is responsible for the following books:

Microsoft Office 2013 For Dummies

Beginning Programming for Dummies

Beginning Programming All-in-One Reference for Dummies

Breaking Into Acting for Dummies with Larry Garrison

Strategic Entrepreneurism with Jon and Gerald Fisher

How to Live with a Cat (When You Really Don't Want To)

The Secrets of the Wall Street Stock Traders

Mac Programming For Absolute Beginners

Republican Fairy Tales (Children's Stories the 1% Tell About the Rest of Us)

The Zen of Effortless Selling with Moe Abdou

The 15-Minute Movie Method

Erotophobia (A novel)

Math for the Zombie Apocalypse

How to Write a Great Script with Final Draft 9

How to Write a Great Script with Fade In

The Elements of a Great Script: Star Wars

The Elements of a Great Script: Die Hard

The Element of a Great Script: Back to the Future

The Elements of a Great Script: Rocky

The Elements of a Great Script: It's a Wonderful Life

In his spare time, Wally likes blogging about movies and writing screenplays at his site "The 15
Minute Movie Method," finding interesting news stories about cats at his site "Cat Daily
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News," giving advice to authors who want to self-publish e-books at his site "The Electronic
Author," and providing the type of advice he wishes someone would have told him when he
was much younger at his personal Web site. Wally can be reached at
wally@computoredge.com or you can follow him on Twitter @wallacewang_com.

August 22, 2014 A Petition for Classic Visual Basic

33

http://www.electronicauthor.com
http://www.wallacewang.com/
mailto:wally@computoredge.com


Editor's Letters: Tips and
Thoughts from Readers
“Computer and Internet tips, plus comments on the

articles and columns.” by ComputorEdge Staff
"Foxit PDF Reader," "I Don't Do Links," "Flash Drives," "LibreOffice Autocorrect"

Foxit PDF Reader
[Regarding Jack Dunning's August 8 article, "Foxit PDF Reading Software (Free)":]

Jack, I'm surprised you only discovered Foxit recently. I've been using for years and love it.

I apologize for not interacting with ComputorEdge for a while. But I recently lost my sight and
have been busy learning to be an able blind person. I was told by my NVDA, Non-Visual
Desktop Access, instructor I needed a paid PDF reader, I forget the name, in order to have
PDFs read to me. I was excited to learn of Foxit's reading mode. I switched mine to list view,
instead of the ribbon, and found I can navigate it just fine in the usual keyboard shortcut
manner, for the blind, then have it read to me. I'm e-mailing this info to my former instructor.

Thank you, once again, for your usual excellent information!

-Paula E Barefoot, Fresno, CA

Jack, based on reader comments about the free software you actually use column, I switched
to Foxit a couple of weeks ago. I found it immediately useful in that it allowed me to assemble
separate PDF files and a fax cover page into a single document I could electronically fax from
my computer. Previously I would have had to either print and scan a stack of paper or
laboriously screen capture and paste into an electronic document.

-Stewart A. Levin, Menlo Park, CA

"I Don't Do Links"
[Regarding the August 8 Digital Dave column:]

Another thing I always tell folks is to look at the status bar at the bottom of your browser
when you put your mouse on a link. Read that link carefully, as often the bad folks will use
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something that looks legit at first glance, but isn't. Like micrsoft.com, vs. microsoft.com. Then
if any doubt, don't click and e-mail the sender to corroborate they sent it and it really is legit
and OK.

-Rich Ernst, San Diego, CA

Flash Drives
[Regarding the August 8 Digital Dave column:]

Dave, you've done it again! Thanks for such a prompt and thorough reply. I appreciate it.

-Gabby DeDonato, San Clemente, CA

LibreOffice Autocorrect
In my computer (Windows 7) the only folder within LibreOffice is "4". Everything is in that
folder.

-Don Bishop, Golden, Colorado

I would backup or move that folder and see the effect of loading LibreOffice without that
folder in the LibreOffice folder. If you don't like the results, you can always restore the "4"
folder.

-Dave

ComputorEdge always wants to hear from you, our readers. If you have specific comments
about one of our articles, please click the "Tell us what you think about this article!" link at
the top or bottom of the specific article/column at ComputorEdge.com. Your comments will
be attached to the column and may appear at a later time in the "Editor's Letters" section.If
you want to submit a short "ComputorQuick Review", or yell at us, please e-mail us at
ceeditor@computoredge.com. If you would like to review our recent e-books, please visit
ComputorEdge E-Books.

Send e-mail to ceeditor@computoredge.com with questions about editorial content.
Send mail to cewebmaster@computoredge.com with questions or comments about this Web site.

Copyright © 1997-2014 The Byte Buyer, Inc.

ComputorEdge Magazine, P.O. Box 83086, San Diego, CA 92138. (858) 484-1998

Click to Visit ComputorEdge™ Online on the Web!
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